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CHAPTER I 

 

INTRODUCTION 

 Your dissertation or capstone project is one of the most important pieces of work 

that you will do. The quality of your document is a reflection not only on you, but also on 

your department, and on The University of Southern Mississippi. Therefore, the Graduate 

School is committed to helping you produce the best document possible, while making all 

final dissertations and capstone projects conform to the University guidelines.  

 After you have successfully defended your dissertation or capstone project, make 

all changes required by your committee before submitting the document to the Reviewer 

of Graduate Dissertations, Nursing Capstone Projects, and Theses (referred to as 

“Reviewer” in the rest of this document) for review (see Chapter V of these Guidelines 

for submission instructions). At this point, no further changes to content are allowed.  Be 

sure that you have formatted your document as required by these Guidelines and be sure 

credit is given to all sources used in your document through appropriate citations and be 

sure all citations have a match in the reference section.  

 Your document must be approved by the Reviewer, who will check your 

document for formatting as required by these Guidelines.  We will spot check grammar, 

spelling, and basic punctuation. We will begin with a spot check of your citations and 

references, this spot check will expand into a full check if problems are noted. If 

substantial issues are noted the document will be returned to you and your committee 

chair will be notified. Prior to submission to the Reviewer, your committee chair will 

check your document for originality by running it through Turnitin and will submit a 

report to the Reviewer (there are serious consequences if any plagiarism is found). If the 

Reviewer does not receive a report from your department she will run it through Turnitin 
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(The Graduate School prefers that the committee do the final Turnitin review). The 

Reviewer does not read for content (along with your committee, this is your 

responsibility). Required modifications to formatting, citations, and references will be 

noted by the Reviewer, and the document will be returned to you. Once all changes have 

been made, resubmit your document to the Reviewer (by the Reviewer assigned due date) 

and once reviewed for the second time, if corrections have been done as instructed with 

no new issues created, the Reviewer will, in most cases, give permission for the final 

copy to be made (instructions will be provided at that time). However, an additional 

review draft may be necessary if all corrections are not done and/or new issues come up. 

Failure to implement the required revisions may result in deferral to a future semester. 

 While deadlines are published on the Graduate School website 

(http://www.usm.edu/graduateschool/deadlines.php), it is advised that you submit your 

dissertation or capstone project to the Reviewer as early as possible after your defense. 

Submitting your document prior to the deadline gives you extra time to deal with 

unforeseen problems. Submitting on the last day (see deadlines) could result in a long 

wait; dissertations/nursing capstone projects are reviewed in the order in which they are 

received. Please see Chapter V for instructions on how to submit your document to the 

Reviewer.  Be sure the document you submit has been defended and approved by your 

committee, no further changes may be made except those changes required by the 

Reviewer. 

 Use your chosen style manual and these guidelines to prepare your document. If 

you hire a professional to type, format, or copy your document, keep in mind that it is 

your responsibility to check every page of your document to be sure everything is correct 

and to follow your style manual and these guidelines. Do not use a previously submitted 

http://www.usm.edu/graduateschool/deadlines.php
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dissertation or nursing capstone project as a guide to prepare any part of your document 

(rules are changing). Follow the instructions set forth in this guide and in your chosen 

style manual to ensure that your work will be in the correct format. 

 In the following pages are guidelines/standards and examples for you to follow as 

you write, edit, and finalize your document. Follow all instructions as closely as possible. 

Any deviations must be pre-approved by the Reviewer. These instructions supersede any 

guidelines in your chosen style manual and these rules are not optional. 

 Be aware that if you turn in a document that does not conform to these Guidelines 

and your chosen style manual, the Reviewer will return your document with a short 

deadline by which you will resubmit your document in the proper format.  Failure to do 

so will delay your graduation.  
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CHAPTER II 

FORMAT 

Style Manuals 

 Your major professor/committee chair should approve your style manual. You 

may use one of the following style manuals in coordination with the Graduate School 

guidelines: 

 • Publication Manual of the American Psychological Association, 6th   

   edition. 

 • MLA Handbook for Writers of Research Papers, 7th edition. 

 • The Chicago Manual of Style, 16th edition. 

 • Kate L. Turabian, A Manual for Writers of Term Papers, Theses, and 

  Dissertations, 8th edition. 

 • The ACS Style Guide: A Manual for Authors and Editors, 3rd edition. 

 • Scientific Style and Format: The CSE Manual for Authors, Editors, and  

   Publishers, 8th edition. 

 • Authors guidelines published in scholarly journals. Provide the Reviewer with 

the guidelines you followed (either a link to the website or a print out). 

  Latex-USM version (Computer Science & Mathematics ONLY); here is the link  

 

  to reach the software:    

 

 http://www.math.usm.edu/mathdept/documents/graduate/USMDissertation.tar.gz 

 

For margins, headings, tables, figures, preliminary pages, appendixes, and the 

order of manuscript elements, the Graduate School guidelines supersede any other 

guidelines or style manual.  If you plan to use a manual not on this list, or if you plan to 

use the guidelines of a scholarly journal, please contact the Reviewer for approval prior 

http://www.math.usm.edu/mathdept/documents/graduate/USMDissertation.tar.gz
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to use.  If you change the style manual you will be using after you have submitted your 

Contact Graduate Reader form – contact the Reviewer for approval prior to use. 

Margins 

Follow these margin settings throughout the document:   

 Left margin – 1.5 inches 

 Top margin – 1 inch 

 Right margin – 1 inch (do not right justify) 

 Bottom margin – 1 inch 

The required margins are necessary for binding. All photographs, prints, figures, tables, 

graphs, etc. must be contained within the margins. Reduce any oversized material to meet 

margin requirements.  The Reviewer will occasionally approve fold-outs for material that 

cannot be reduced to fit the required margins. Be sure the full fold-out is viewable in your 

electronic file (Word).  If you hope to use foldouts please obtain permission from the 

Reviewer before you begin work.  Photographs must be reproduced for all copies of the 

document (printed and electronic). Where necessary, it is acceptable to use color for 

photographs, tables, and figures; everything else should be printed using black ink.  Be 

sure you have permission from the publisher/author to use any photographs, tables, 

figures, etc. and be sure they are properly cited (letters granting this permission should be 

included in your Appendix). 

Headings 

Each chapter should begin on a new page and be headed according to its chapter 

number.  The first chapter should be headed CHAPTER I, the second, CHAPTER II, etc.  

Center the heading, use all caps, and always use Roman numerals for the numbers. Do 

not use word numbers, and do not use Arabic numerals. 
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Chapter titles function as major headings. These should be centered and in all 

capital letters. Do not italicize or bold. For example, a chapter titled Introduction should 

appear as INTRODUCTION, centered and double-spaced beneath the numbered chapter 

heading. Each new chapter begins on a new page. 

Headings under chapter titles (the major sections of chapters) should be centered 

in the text and listed in the TABLE OF CONTENTS (TOC). Capitalize the first letters of 

major words. Do not use bold or italics. Double space before and after the headings. 

The next level of heading (major subsections of chapters) should be flush left and 

italicized. Double space before and after the headings.  Do not list these headings in the 

TOC. 

The next level of heading (second subsections of chapters) should be centered and 

italicized with major words capitalized. These subsections appear infrequently. If you use 

this heading, be sure you use it correctly. Do not list these headings in the TOC. 

The next level of heading (paragraph headings) should begin the paragraph. They 

should be indented one half (.5) inch, italicized, and ended with a period. Capitalize only 

the first word, and begin the paragraph on the same line as the heading. Do not list these 

headings in the TOC. 

If lined up in order, the headings would appear this way: 

CHAPTER I 

INTRODUCTION 

         Statement of the Problem 

First Subsection 

Paragraph heading.  Paragraph begins here. 

Second Subsection (if necessary) 
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For students in the College of Science and Technology the Reviewer will 

occasionally allow the following headings to be used (lined up in order).  Obtain 

permission from the Reviewer before using these headings; all other students should use 

the headings shown previously. 

CHAPTER I 

INTRODUCTION 

1.1 Statement of the Problem 

1.1.1 Subsection 

           1.2 Methodology 

1.2.1 Subsection 

If these headings are used you should use the designated Table of Contents example in 

Chapter VII.  This does not change the way Tables and Figures should be numbered as 

per these Guidelines. 

Running Heads 

Please do not use “running heads” anywhere in your manuscript. 

Font 

Times New Roman font, 12-point, in black color, is the preferred font. Arial, 12 

point, in black is permitted. You should have selected the font type when completing 

your Contact Reviewer form. If you decide to change fonts, notify the Reviewer of the 

change before defense. The font style used for your dissertation/project must be the same 

as the font used for your signed title pages (previously approved by the Reviewer). 
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Spacing and Indentions 

Except for figure captions, use double spacing throughout the main text—within 

and between paragraphs, between headings and paragraphs, within headings, etc.  

Double-space table notes as well, using Arial or TNR 8-point font. The first line of each 

paragraph should be indented one half (.5) inch. Do not triple or quadruple space 

anywhere (be sure you have corrected the settings in Word to prevent this). 

Page Numbers 

Preliminary Pages 

On the pages that require numbering, use lower case Roman numerals, centered, 

placed 1 inch from the bottom of the page (resting on margin). If using an Insert function, 

check the software program’s default setting to ensure the fonts of the text and page 

numbers match. The first page of the Abstract is page ii (the copyright page and the title 

page with signature lines are not numbered and do not count in the numbering; the 

Abstract title page is not numbered and does count in the numbering) (see Appendix for 

instructions/settings). 

Main Text, Appendixes, and References 

In the current Guidelines the page numbers are placed in the top right corner of 

the page, 1 inch from the right edge of the page and .5 inch from the top of the page. The 

font type and size should be the same as the font of the text. If using an Insert function, 

check the software program’s default setting to ensure the fonts of the text and page 

numbers match. In the new template, that will be out soon, the page numbers in this 

section will be placed at the bottom of the page, centered at the bottom margin.  You may 

choose either numbering style (see Appendix for instructions/settings).  The first page of 
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Chapter I is page 1, pages that follow should continue from that point through the end of 

the reference section. 

Tables 

Place each table within the text as near to its in-text discussion as possible, this is 

done for the sake of readability and ease of use. More than one table may be on a page. 

For a few of the scientific journal styles tables may be placed at the end of each chapter 

or in the Appendixes/Appendices (obtain permission from the Reviewer before using this 

option).  Be consistent with how tables are placed throughout your document.  Every 

table must be checked for completeness, mathematical correctness, and agreement with 

the explanation in the text of the document. The table should be headed with the word 

Table, followed by the corresponding Arabic numeral according to its sequence.  Double 

space the table’s name below the heading and above the table on the same page.  In most 

circumstances, tables should be numbered sequentially from the beginning to the end of 

the text.  If necessary, they may be numbered sequentially in each chapter (Table 1.1, 

Table 1.2 in Chapter I).  Separate the table from the text with a double space before the 

table heading and after the end of the table. Tables must fit the same margin requirements 

as the rest of the text.  Bolded lines should extend margin to margin, without crossing 

either margin. See the next two pages for examples – the first section shows how a table 

begins, the second section shows how to continue a table onto a subsequent page(s). 

Tables in landscape format are permitted.  Keep in mind that they must fit within 

the same margins as portrait pages, the page number must be in the same position as it 

would be for a portrait page.  The headings begin at what would be the bottom left hand 

corner of a portrait page – but sideways.  For more information, email the Reviewer 

 



 

 

10 

 

Table 4 

Fit Indices of Cross-Sectional Models 

 

Model     χ ² NFI PFI   χ ² diff NFI 

 

 

1.  Mobley’s (1997) 

        measurement model           443.18*  .92  .67 

 

2.  Quit & search intentions           528.80*  .89  .69 

     Difference between  

     Model 2 and Model 1       86.61* .03 

 

3.  Search intentions & 

     thoughts of quitting          519.75*    .90  .69  

     Difference between  

     Model 3 and Model 1      76.57*  .02 

 

 

 

 

 

 

 

*For the sake of this example, pretend this blank area is filled with data. At the end of the 

table add a line.  If the table is split over two pages the line should also appear at the 

bottom of the table on the first page, 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If the Table extends onto a second page format as shown on the next page. 
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Table 4 (continued). 

 

 

              Model         χ ² NFI PFI   χ ² diff NFI 

 

 

 

4.  Intentions to quit &  

     thoughts of quitting          546.97*  .89 .69 

     Difference between  

     Model 4 and Model 1      103.78* .03 

 

5.  One withdrawal cognition         616.97* .87 .70 

     Difference between  

     Model 5 and Model 1      173.79* .05 

 

 
Note. NFI = normed fit index; PFI = parsimonious fit index. From “Structural Equations Modeling Test of a Turnover Theory: Cross-

Sectional and Longitudinal Analyses,” by P. W. Hom and R. W. Griffeth, 1991, Journal of Applied Psychology, 76, p. 356. Copyright 

1991 by the American Psychological Association. Reprinted with permission of the author. 

*p< .05. 

 The note below the table should be double-spaced and in 8-point font (same font 

as text but smaller).  Regardless of the style manual you follow, use the Graduate School 

guidelines for tables.   

Illustrations 

Illustration titles/captions should go below the illustration. Place each figure 

within the text as near to its in-text discussion as possible, this is done for the sake of 

readability and ease of use.  More than one figure may be on a page. For a few of the 

scientific journal styles figures may be placed at the end of each chapter or in the 

Appendixes/Appendices (obtain permission from the Reviewer before using this option).  

Be consistent with how figures are placed throughout your document. Illustrations must 

fit the same margin requirements as the rest of the text.  Each illustration and its caption 

should appear together on the same page.  Double-space above the figure and below the 



 

 

12 

 

caption.  See the next page for an example.  Use this format for all illustrations including 

figures, photos, examples, etc. 
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Figure 10. The first line will be listed in the List of Illustrations. Briefly explain all 

information presented in the figure, including abbreviations, colors, etc. Cite the source 

of the figure if it was one you did not create. Cite as required by your style manual. 

Copyright date and owner. Adapted with permission of the author. 

 

 

 Figure captions should be single-spaced as shown. In most cases, figures should 

be numbered sequentially from the beginning to the end of the text. If necessary, they 

may be numbered sequentially in each chapter (Figure 1.1, Figure 1.2 in Chapter I).   

Please note that Figure and its number are italicized and the rest of the caption is not 

italicized. Please do not abbreviate the word Figure in the caption or anywhere it is 

mentioned in the text. 

Figures, tables, or other illustrations taken from other sources should be used with 

permission from the author, publisher, or copyright holder. Be sure to obtain permission 

in writing (email or letter) and include the letter or email in your Appendixes. 

Regardless of the style manual you follow, use the Graduate School guidelines for 

illustrations. 
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Figure 11.  The moment after hooding.  This is what you have to look forward to 

(photograph by Candid Campus Photography, Inc., used with permission). 
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CHAPTER III 

ELEMENTS OF THE MANUSCRIPT 

Order of Dissertations and Nursing Capstone Projects 

**Option #1 – current guidelines – choose this order OR the one below, please don’t mix 

and match 

Preliminary Pages (numbered using lower case Roman numerals, bottom center) 

 Flyleaf (blank page – not numbered, not counted) insert manually into final  

paper copies – this page should not be part of your electronic file. 

 Abstract Title Page (not numbered, but counted) 

 Abstract (numbered, bottom center) – this is page ii 

 Copyright page (not numbered, not counted) text centered vertically and 

horizontally 

 Title page – type in the Reviewer approved version of your title page – be  

sure to match all spacing and placement exactly.  See example. 

 Dedication (optional, numbered, bottom center) 

 Acknowledgments (numbered, bottom center) 

 Table of Contents (numbered, bottom center) 

 List of Tables (numbered, bottom center) 

 List of Illustrations (numbered, bottom center) 

 List of  Equations or Schemes (if necessary, numbered, bottom center) 

 List of Abbreviations (optional, numbered, bottom center) 

Main Text 

 Text (Chapter I starts with page 1) 
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Appendixes and References 

  Appendixes (numbered as continuation of main text) 

  References (numbered as continuation of main text) 

  Flyleaf (blank page – not numbered, not counted) insert manually into final 

paper copies – this page should not be part of your electronic file. 

**Option # 2 – this is the required order in the new template coming out soon.  You are 

welcome to use this order.  Just don’t mix and match between the two options. 

Preliminary Pages (numbered using lower case Roman numerals, bottom center) 

 Flyleaf (blank page – not numbered, not counted) insert manually into final  

paper copies – this page should not be included in your electronic file. 

 Title page (not numbered) – type in the Reviewer approved version of your title  

page. Be sure to match all spacing and placement exactly. 

 Copyright page (not numbered, not counted) text centered vertically and 

horizontally 

 Abstract (numbered, bottom center) first page of Abstract is page ii 

 Acknowledgments (numbered, bottom center) 

 Dedication (optional, numbered, bottom center) 

 Table of Contents (numbered, bottom center) 

 List of Tables (numbered, bottom center) 

  List of Illustrations (numbered, bottom center) 

  List of Equations or Schemes (if necessary, numbered, bottom center) 

  List of Abbreviations (optional, numbered, bottom center) 

Main Text 

 Text (Chapter I starts with page 1) 
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Appendixes and References 

 Appendixes (numbered as continuation of main text) 

 References (numbered as continuation of main text) 

 Flyleaf (blank page – not numbered, not counted) insert manually into final 

paper copies – this should not be included in your electronic file. 

Preliminary Pages 

Except where noted otherwise, number all preliminary pages with lower case  

Roman numerals at the bottom center, resting on the 1” bottom margin. Examples of each 

of these elements can be found toward the end of this document. 

Flyleaves 

Flyleaves (blank pages) are not part of the text, so they are neither counted nor  

numbered. Flyleaves should not be a part of your Word file as they can affect your ability 

to correctly number your pages. Manually insert these blank pieces of paper into your 

paper draft (one on top, one on the bottom) once the Reviewer gives you permission to 

make your final paper copy. 

Dissertation Abstract 

Write a short description of your dissertation/project (no more than 350 words).   

Abstracts of more than 350 words will be shortened by UMI/ProQuest. An unnumbered  

abstract title page should introduce the abstract. The abstract should be page ii of your  

dissertation/project. Place the page number at the bottom center of the page, 1” from the 

bottom. Center the word ABSTRACT one inch from the top of the page. Type the title of 

the dissertation/project in all caps on the next line(s), followed by your full name (no 

initials), with your expected graduation month (December, May, or August) and year 

beneath your name. If the abstract continues beyond one page, begin the following pages 
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one inch from the top, and continue the page numbers at the bottom center. List the 

abstract in the Table of Contents. See the example at the end of this document. 

Copyright Page  

This page is neither counted nor numbered. Center vertically and horizontally on  

the page, in all caps, on three lines, double-spaced: COPYRIGHT BY / YOUR FULL 

(First, Middle, Last) NAME / THE YEAR OF GRADUATION. 

Title Page 

Have the title page approved by the Reviewer during the semester prior  

to your defense. See the Graduate School Dissertation/Thesis Deadlines on the Graduate  

School website. If you make any changes to your title page, resubmit your title page to  

the Reviewer immediately to be approved again. If the signed title pages do not match the 

approved title page, you will be required to redo the title pages and signatures.   

You will need at least two (2) signed copies of your title page printed one on 

white 100% cotton paper (20-32 lb.) and one on regular paper (originals, not 

photocopies). If you plan to have copies of your  dissertation or capstone project bound 

for your own use, provide the Reviewer with enough signed title pages for the extra 

copies (within reason). For example, if you plan to bind one copy for yourself, provide 

the Reviewer with three (3) signed title pages. If you order your bound copies from 

ProQuest, extra signed title pages are unnecessary. Committee members should sign the 

title pages in black ink. Please note that the Graduate School will not send your extra 

dissertation/project copies for binding, but contact information for the recommended 

binderies will be on the instructions provided when the Reviewer gives you permission to 

make final copies. 
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Instructions for the Title Page Template  

Click here to go to the template (read the instructions first) 

Due to the compatibility issues between Word for Mac and Word for PC, you need to 

create your title page on a Windows based PC using a recent version of Word.  The 

approved version of your title page that the Reviewer will send back to you will be usable 

on a Mac or a PC. 

 Before you begin, decide if you will be using Times New Roman 12 point font or 

Arial 12 point font as you write and format your dissertation or nursing capstone project.  

Then select the template that is set up with your chose font.  An example of a completed 

title page appears in Chapter VII of these guidelines.  Be sure that the Graduate School 

has received your Graduate Committee Request form and that your committee has not 

changed since it was submitted. 

 The title page template is made up of a series of drop down menus and fill in the 

blank boxes.  There is also content that must not be changed.  Once you complete the 

steps below, email the title page to the Reviewer for approval.  The Reviewer will make 

any necessary corrections or additions and email the approved version of your title page 

to you with instructions for use.  If you need to make any changes later, make the 

changes on the approved version of your title page and resubmit to the Reviewer for 

approval (do this even if the changes if very small). 

It is very important that you follow these instructions as you create your title page.  Do 

not attempt to change the template. 

 Click on the first box and type in your title – the title should be all caps, do not use 

bold.  The template will automatically double space the title for you.  Longer titles 

should be formatted to look like an upside down pyramid.  Please note that if 

there are words within your title that need to be italicized the template will not 

http://www.usm.edu/graduate-school/reviewer-dissertations-nursing-capstone-projects-theses-formerly-graduate-reader
http://www.usm.edu/graduate-school/progress-degree-and-graduation-forms
mailto:jeanne.stewart@usm.edu
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allow it.  When you submit the title page to the Reviewer for approval, type or 

copy/paste the title into the body of the email and italicize the necessary word(s).  

The Reviewer will make the change for you in the approved version of the title 

page. 

 Do not make any changes to the next line – “by” should remain as is. 

 Click on the box labeled “type your full name here” – highlight the text that is in 

the box and type your full name in the box. We prefer that you use your full first, 

middle, and last name.  Please do not enter any nicknames. 

 Click on the drop down menu on the next section where it says “chose an item” – 

select Dissertation, Thesis, or Capstone Project. 

 Do not make any changes to the line “Submitted to the Graduate School” 

 After the words Department of – click on the drop down box and select your 

department.  If your department isn’t listed, type the name of your department 

into the body of the email and the Reviewer will check it and make the change for 

you.  Please note we are not looking for the program or subject area – we require 

the name of the department your degree will come from.  There are four 

“departments” that begin with “School of” – for those four you will need to edit 

out the words “Department of” and click on save. 

 Do not make any changes – to the next two lines. 

 In the line that begins with “for the Degree of” Click on the drop down box and 

select the correct degree. 

 Do not make any changes to the next line – “Approved:” 
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 Signature Lines:  You will be providing the names and academic ranks (not 

administrative titles) of each professor on your committee in this section.  You 

can find the needed information by clicking here 

 The signature lines themselves should not be edited in any way 

 Below each line you will need to complete each item exactly as follows: 

 In the first box type in the professors name.  Format the names as 

follows – Dr. Jane Doe if they have a doctoral degree or as Jane  

Doe if they do not have a doctoral degree (no nicknames). Middle 

initials are not required, but be consistent. 

 In the second box select the appropriate committee status from the 

drop down menu – the first signature line will always be the 

Committee Chair.  In most cases the rest will be Committee 

Member. 

 In the third box select the professors academic rank from the drop 

down menu (don’t add to or alter these – if the correct choice is not 

there, let the Reviewer know and she will fix it) 

 In the fourth box select the professors department from the drop 

down menu.  Do not alter or add to these choices – if something is 

missing, let the Reviewer know and she will fix it).  Note this is the 

professors department, not subject area. 

 If any of your committee members are from an outside entity fill in 

their name and committee status as noted above.  Do not attempt to 

fill in the reset, let the Reviewer know the rest of the information 

http://apps.usm.edu/itech/onlinedirectory/
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and once she has verified it, she will add it to the approved version 

of your title page. 

 The template provides space for five committee members.  If you 

have fewer than five members leave those lines blank and the 

Reviewer will remove the unused fields.   If you have a sixth 

member (very rare) include the information in the email the title 

page is attached to and the Reviewer will add that committee 

member to the page for you. 

 The last signature line is for the Dean of the Graduate School – do 

not alter the line or the information in any way. 

 Finally, click on the drop down menu that is at the bottom, center of the page and 

select the month and year of your anticipated last semester.   

 If the title page extends to a second page, the Reviewer will make the necessary 

adjustments to make everything fit on one page. 

The Reviewer will send an approved version of your title page to you via email 

with instructions for its use.   If you find that you need to defer to a future semester, the 

Reviewer will update the approved title page and send you a new approved version at that 

time. 

Dedication (Optional) 

If you plan to include a dedication, follow the formatting guidelines for the  

acknowledgments. Place personal expressions of gratitude, such as those addressing 

family members, in the dedication. 
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Acknowledgments 

Acknowledgments should maintain a scholarly and professional tone.   

Expressions of gratitude in this section should be addressed to those who have assisted in  

the production of the document and to those who have given you permission to use  

copyrighted material. Personal expressions of gratitude, such as those addressing family  

members, should be placed in the dedication. The word ACKNOWLEDGMENTS  

should appear one inch from the top of the page, centered. Paginate sequentially after the  

Abstract, bottom center. If the acknowledgments continue beyond one page, begin the  

following page(s) one inch from the top. Please note that while acknowledgements is also 

a correct spelling, acknowledgments is the preferred spelling in the United States and this 

office expects you to use the U.S. spelling. 

Table of Contents (TOC) 

List your Abstract, Dedication, Acknowledgments, List of Tables, List of 

Illustrations, etc. flush with the left margin in all caps. Do not list the Table of Contents 

in the TOC. Indent chapter numbers one half (.5) inch. List chapter titles in all capital 

letters. Number the chapters with upper case Roman numerals. List only the major 

sections of each chapter. Do not list subsections of the major sections. Indent chapter 

titles and major section titles/headings one half (.5) inch from the chapter Roman 

numeral. Use upper and lower case for major section titles. List only the page numbers 

that correspond to the beginnings of each section of the preliminary pages, to the 

beginnings of each chapter, and to the beginnings of the appendixes and references. Do 

not list page numbers for major section titles/headings. Preliminary page numbers, 

chapter page numbers, and appendixes and references page numbers should align evenly 

with the right margin. Place a series of dots between the title and corresponding page 
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number. Center the words TABLE OF CONTENTS one inch from the top of the page. 

Paginate the TOC sequentially after the acknowledgments, bottom center. If the TOC 

runs beyond one page, begin the following page(s) one inch from the top. See the 

example in Chapter VII. 

List of Tables (LOT) 

The LOT sequences the tables from the main text in list form in the order that  

they appear. Use upper and lower case for table titles. The titles in the text should match 

the titles in the LOT word for word. Center the words LIST OF TABLES one inch from 

the top of the page. Paginate the TOC sequentially after the acknowledgments, bottom 

center. If the list continues beyond the first page, begin the following page(s) one inch 

from the top. List only the page numbers that correspond to the beginnings of each table.  

Page numbers should align evenly with the right margin. Place a series of dots between 

the title and corresponding page number.  See example in Chapter VII. 

List of Illustrations (LOI) 

The LOI sequences the figures from the main text in list form in the order that  

they appear. Use upper and lower case for table titles. The titles in the text should match 

the titles in the LOI word for word. Center the words LIST OF ILLUSTRATIONS 

(music students may entitle their lists LIST OF EXAMPLES) one inch from the top of 

the page. Paginate the LOI sequentially after the TOC, bottom center. If the list continues 

beyond the first page, begin the following page(s) one inch from the top. List only the 

page numbers that correspond to the beginnings of each table. Page numbers should align 

evenly with the right margin. Place a series of dots between the title and corresponding 

page number. See example in Chapter VII. 

List of Schemes (LOS) (if necessary) 
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The LOS sequences the schemes from the main text in the order that they appear.  

Use upper and lower case for scheme titles. The titles in the text should match the titles in 

the LOS word for word. Center the words LIST OF SCHEMES one inch from the top of 

the page. Paginate the LOS sequentially after the previous list, bottom center. If the list 

continues beyond the first page, begin the following page(s) one inch from the top. Page 

numbers should align evenly with the right margin. Place a series of dots between the title 

and corresponding page number. Model this according to the example of the List of 

Illustrations in Chapter VII. 

List of Abbreviations (LOA) (optional) 

 The LOA should include abbreviations used throughout the text that indicate  

professional or scholarly terms, such as jargon, agencies, legislation, etc. The list should 

be centered with abbreviations in italics. Paginate the LOA sequentially after the previous 

list, bottom center. Center the words LIST OF ABBREVIATIONS one inch from the top 

of the page. If the list continues beyond the first page, begin the following page(s) one 

inch from the top.  See the example in Chapter VII. 

Main Text 

 The main text should be double-spaced throughout. The first line of each  

paragraph should be indented one half (.5) inch. If your document includes symbols,  

foreign characters, or mathematical equations, you must either produce them  

with computer graphics or have them produced professionally. 

In-text Citations (applies to footnotes and endnotes) 

Each style manual, including APA and MLA, publishes its own guidelines for in- 

text citations and references. Consult your selected style manual for guidelines on how to  
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format citations and references. We strongly urge you to check your citations/footnotes/ 

endnotes against your references/bibliography/works cited section before turning your 

dissertation into this office.  Make sure every citation has a matching entry in the 

references and make sure you have formatted both the citations and references according 

to your selected style manual. We check the citations and references against the  

selected manual for format compliance.  The omission of a cited work from the reference 

section may constitute plagiarism. All in-text citations should reference a work in the 

reference section. Failure to properly cite quoted material, paraphrased material, charts, 

etc. from other sources is plagiarism. Cook Library provides citation/reference help using 

RefWorks and Write-N-Cite, which can be found at: http:/libguides.lib.usm.edu/citation_help.  

We strongly urge all students to take advantage of this service. 

Lists 

 When creating any lists within your document using bullet points or numbers be 

consistent with the type of bullet point and, if using numbers, use 1. as opposed to (1) or 

1). 

1.  Be consistent with the spacing and placement of each item – example you 

should indent the first line and align the second line as shown here in most 

cases. 

2. The indentation and spacing should be the same if you are using bullet points. 

Appendixes/Appendices and References 

Appendixes/Appendices 

Center the words, APPENDIX A (or B, or C, etc.) one inch from the top of the  

page. All appendixes must be titled. The title must be all caps, centered, and double-

spaced beneath the appendix heading. Do not include a separate heading page labeled 

http://libguides.lib.usm.edu/citation_help


 

 

26 

 

APPENDIXES/APPENDICES or place the word APPENDIXES/APPENDICES above 

APPENDIX A. Reduce or adjust all appendixes so that they fit the margin requirements 

of the rest of the text. Paginate the appendixes as a continuation of the main text. If there 

are items included in your appendixes that are formatted as tables or figures, they should 

not be labeled as such. Tables and figures should be placed in the main text. If there is 

more than one Appendix, you may list this section as APPENDIXES or APPENDICES in 

the Table of Contents (if there is only one Appendix, list APPENDIX in the Table of 

Contents).  Place your Appendixes/Appendices after the last chapter and before your 

References. 

References 

Title the References section according to your style manual. For example, some 

manuals prefer WORKS CITED, some REFERENCES, and some BIBLIOGRAPHY.  

Center the heading in all capital letters, one inch from the top of the page.  Paginate as a 

continuation of the main text or the Appendixes/Appendices if you have one. 

APA and MLA require the References section to be double-spaced throughout  

with hanging indentions for every line subsequent to the first line of each entry.   

 

For References section guidelines other than APA or MLA, consult the particular style  

manual or journal you plan to use. See the section on in-text citations for a link to 

RefWorks which will assist you with the formatting of your Reference section. 
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CHAPTER IV 

RESEARCH COMPLIANCE 

Plagiarism 

 According to the USM Graduate Bulletin, “academic and research integrity are 

critical to high standards in graduate education. Incidents of academic or research 

misconduct will incur sanctions as defined in the Academic Integrity Policy (ACAF-

PRO-012)” (2014-15 Graduate Bulletin, General Academic Information, 

http://catalog.usm.edu, 2014). The 2014-15 Graduate Bulletin (2014) goes on to define 

plagiarism as follows: 

One of the most common acts of academic misconduct is plagiarism. The 

following description may aid students in understanding what constitutes 

plagiarism: 

 Plagiarism is scholarly theft, and it is defined as the unacknowledged use of 

secondary sources. More specifically, any written or oral presentation in 

which the writer or speaker does not distinguish clearly between original or 

borrowed material constitutes plagiarism. 

 Students, as scholars, must make frequent use of concepts and facts developed 

by other scholars. Plagiarism occurs when students present the work of other 

scholars as if it were their own work. Students may refer in their own words to 

generally known and widely accepted ideas or theories without fear of 

plagiarism as long as they do not copy the plan or organization scheme used 

by another scholar. 

 Plagiarism is committed in a number of ways including the following: (1) 

reproducing another author’s writing as if it were one’s own; (2) paraphrasing 

http://catalog.usm.edu/
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another author’s work without citing the original; (3) borrowing from another 

author’s ideas, even though those ideas are reworded, without giving credit; 

and (4) copying another author’s organization without giving credit. 

 Plagiarism is avoided when appropriate citations are used giving credit to the 

original source in the following instances: (1) when quoting directly from 

someone else’s writing (a direct quotation must always be enclosed in 

quotation marks or formatted as a block quote); (2) when paraphrasing 

someone else’s writing (to paraphrase means to restate a passage from 

someone else’s writing in one’s own words); or (3) when following the outline 

or structure of another author’s argument, explanation, or theory, even though 

the material is summarized in one’s own words. 

 When in doubt about how widely known ideas are, a student should observe 

these steps: (1) ask his/her instructor; (2) provide credit to the original source. 

Quotations and Paraphrase 

Follow your style guide and your committee's suggestions for quoting and  

paraphrasing material. Make sure that all material that is not your own has been properly   

cited.  A page number from the original source should be assigned to every quotation. If  

you tend to use quotation marks for special terms or for emphasis, use italics for those 

words and phrases instead. If you have any questions, contact the Reviewer. 

Currently, the copyright laws allow you to quote the following without  

permission from the publisher of the work (citations are still necessary):   

•  Passages of less than a few paragraphs;  

• Works published by the U. S. government; and  
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• Works on which the copyright has expired (anything published in the United  

   States before 1906; anything by an author who has been dead at least 70 years). 

The length of a quotation requiring permission differs among publishers, and  

many publishers do not require permission for quotations used in dissertations/projects,  

even for long quotations. If you have any doubt about the need for permission, write the  

publisher of the work.  

 The Graduate School strongly urges all students to submit their work to Turnitin 

or another similar service.  Contact the Reviewer or the USM Writing Center for more 

information. 

The University of Southern Mississippi Graduate School, Aquila/Cook Library, 

 and UMI/ProQuest assume no responsibility for direct quotations used without  

permission or for improperly attributed paraphrasing. 

Institutional Review Board (Human Subjects Review) 

 The University of Southern Mississippi and the U. S. Department of Health and  

Human Services have established standards and guidelines to protect individuals from  

risks associated with participation as subjects in research studies. The University’s  

Institutional Review Board (IRB) is responsible for ensuring that adequate safeguards are  

in place to minimize the risk to individuals involved in such studies. 

 All investigations, experiments, surveys, or demonstrations involving human  

subjects, regardless of funding considerations, must be reviewed and approved  

by the Institutional Review Board before the research, survey or other activity begins. 

This includes research activities that a faculty member is supervising such as class 

projects, master’s theses, projects, and doctoral dissertations. 
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 Application forms for submission of protocols for review by the Institutional  

Review Board are available from each college’s representative and from the Office of  

Institutional Review Board.  For IRB information go to www.usm.edu/irb.  Prior to 

submitting the required copies of an IRB application, secure the appropriate signatures 

and have the application reviewed by your college representative to the Institutional 

Review Board.  See the Graduate Bulletin – http://catalog.usm.edu/index.php 

Include the approval letter and the signed and approved IRB application  

forms in an appendix of the dissertation  or capstone project. The names of the  

college representatives to the IRB may be obtained from your college dean’s office or 

from the Office of Institutional Review Board at 601-266-5997, Jo Ann Johnson, 

Manager for the Institutional Review Board (IRB@usm.edu) or visit 

http://www.usm.edu/research/institutional-review-board  

Institutional Animal Care and Use Committee 

 The Institutional Animal Care and Use Committee (IACUC) is a standing  

committee of the university. The IACUC is qualified through the experience and  

expertise of its members to oversee the university’s animal program, facilities, and  

procedures. The IACUC consists of eight members (six regular and two ex officio). An  

audits membership meets the compositional requirements set forth in the Public Health  

Service Policy.  The IACUC, through an appointed chairperson, reports directly to the  

Vice President for Research. The IACUC acts as a monitor to ensure the university  

facilities are operated in compliance with the Public Health Service Policy and with other  

federal policies. 

 Federal law requires that any university activity involving the use of vertebrate  

animals, whether research or instructional in nature, be reviewed by the IACUC and  

http://www.usm.edu/irb
http://catalog.usm.edu/index.php
mailto:IRB@usm.edu
http://www.usm.edu/research/institutional-review-board
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approved by that body before the activity may proceed. The original completed form  

should be signed by the project director (a faculty member not a student), the appropriate  

departmental chair, and the dean. Nine (9) copies should be forwarded to the Chair of the  

IACUC for processing. Review of applications requires approximately two to six weeks.  

The approved IACUC protocol application form should be included in an appendix of the  

dissertation  or capstone project.  IACUC review applications may be obtained  

from the IACUC Administrative Assistant, Box 5116, 601-266-6791 or iacuc@usm.edu. 

See  http://usm.edu/research/institutional-animal-care-and-use-committee 

 If your study will require IRB or IACUC approval, obtain that approval before 

you begin your study.  It is a violation of Federal law and University rules to begin any 

study without this approval in place. Do not make the mistake of starting your study 

before you have received approval.  Please scan and email a copy of your approval letter 

to the Reviewer as quickly as possible after your Proposal has been approved. 

 

 

 

 

 

 

 

 

 

 

 

mailto:iacuc@usm.edu
http://usm.edu/research/institutional-animal-care-and-use-committee
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CHAPTER V 

SUBMITTING THE DOCUMENT 

Once you have defended your dissertation or capstone project, if any committee 

revisions are required, be sure the revisions are approved by your committee chair before 

submitting the file to the Reviewer.  Once your committee approves your document and 

your committee chair has emailed the Reviewer stating that the revisions are approved, 

you will submit your dissertation or nursing capstone project to the Reviewer. 

Submission of Document 

First be sure your document is contained in one Microsoft Word file in the 

required order (see Chapter III), with all required elements, and formatted as required by 

these Guidelines.   Be sure you have accurately followed all requirements of these 

Guidelines and remember these Guidelines supersede your style manual anywhere that 

they differ. Be sure all spelling, punctuation, and grammar errors are corrected before 

submission.  Be sure you have correctly formatted your citations and references 

according to your chosen style manual (you chose this at the time you submitted your 

Contact Reviewer form*).  Be sure all direct quotations are properly cited and that any 

and all uses of another scholars’ material (direct quote or not) receives due credit; any 

appearance of plagiarism must be avoided. This will help speed up the process for you 

and for us.  *(this form may still be called Contact Graduate Reader form) 

Submission Method – Aquila 

Once you are ready to submit your document to the Reviewer, follow these steps: 

Initial Submission (if this is not your initial submission – find the directions that follow 

for submitting revised drafts) 
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1. Go to http://aquila.usm.edu/dissertations - DMA, EDD, PHD candidates use this link.              

Go to http://aquila.usm.edu/dnp_capstone - DNP candidates use this link.  

2. Under the Author Corner section on the left side of the page, click the Submit Research 

link . 

3. Log in with your email address and password (If you have not yet created an account, 

click the Sign Up button and follow the steps provided to do so). 

4. Complete all fields on the electronic form provided (Note: for the Date of Award field, 

select only the month and year that you expect to graduate) see instructions – go to the 

“Helpful Hints” section of these Guidelines for instructions regarding this form. 

5. Upload the full text of your document in Microsoft Word format (.doc or .docx) **  

6. Click Submit. 

7. Once you receive confirmation that the document has been submitted successfully, 

click on My Account and log out.  

The Reviewer will receive a notification that your file is available for review.  

How to pull the Reviewers’ “marked” file (the file you will work from when making 

revisions): 

1.  Log in using your USM email address and the password you set up at the time of the 

initial submission. 

2.  Click on your document title 

3.  Just above the heading “Submission Metadata” you will see two choices for files to 

download – download the .docx file (latex users only download the pdf).   Save the file to 

your desktop. 

http://aquila.usm.edu/dissertations
http://aquila.usm.edu/dnp_capstone


 

 

34 

 

4.  Complete all of the revisions – do not change the file name, do not remove our 

comments. 

How to send your revised file back to the Reviewer for review. 

 1.  Log in as before. 

 2.  Click on your document file. 

 3.  In the list of choices on the left side of the screen, select “Revise Thesis/Dissertation” 

 4.  Scroll all the way down to find the spot to upload your revised draft/file.   As you 

scroll down do not change any of the information in the form. (The only exception will 

take place when you have been cleared for finals --– if there have been any changes to 

your Abstract, you will need to delete what is on the  Aquila form and then copy/paste the 

new version into the designated area). 

If additional revisions are required after the Reviewer reviews your document a second 

time, some of these steps will be repeated. 

Until your document has been cleared by the Reviewer for finals (at least 2 steps 

down the road), your document is only visible on Aquila to the Reviewer and yourself. 

Once it is cleared for finals the Reviewer will publish it on Aquila (with any embargos 

placed on the document in mind).  

**Latex users – you may send your document in pdf format – this exception is 

ONLY for Latex (Latex is used only by the Math department and some Computer Science 

students).  

Be sure to follow the USM Guidelines at all times - found in the Graduate Reader 

section of the Graduate School website:  http://www.usm.edu/graduate-school/graduate-

reader (this area of the website will change names to reflect the new job title soon).  Any 

http://www.usm.edu/graduate-school/graduate-reader
http://www.usm.edu/graduate-school/graduate-reader
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late or incomplete submissions are likely to result in the need to defer your graduation to 

the following semester.  

The Reviewer Process 

The Reviewer will review and mark the text for necessary revisions.  Do not 

remove the Reviewer comments as you make the corrections; the Reviewer will remove 

the comments as your document is checked the second time.   

Work only from the most recent Word file sent to you by the Reviewer; the 

Reviewer will rename the file you send in a way that will make it clear which file you 

should be working with (do not change the file name). Do not go back to an earlier file. If 

you use an earlier version of the file to make your corrections and then resubmit it to the 

Reviewer, the file will not be accepted, and all corrections will have to be redone using 

the correct file. There will be a checklist returned with the file that will include a due date 

for the corrected file to be returned (do not miss this due date), basic instructions needed 

to make the corrections, and any necessary examples (the checklist and examples will 

come via email – the marked draft will be returned through Aquila). 

Any changes to content after the document has been submitted to the Reviewer 

and/or any other unauthorized changes will slow or stop the review process, which may 

result in the need for you to defer your graduation until the following semester. The 

amount of time this process will take depends entirely on your willingness to make 

the marked revisions as instructed. Documents turned in on or just before the final 

deadline will be reviewed in the order received. If you defend earlier in the semester, it is 

to your advantage to submit the document as far ahead of the final deadline as possible. 

Once your place in line is reached, the speed of our work depends almost entirely on the 

condition in which you submit the document. Any dissertation/capstone project submitted 
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in poor condition is likely to be returned to you without comment to be revised – a short 

period of time will be given for these changes to be made. The Reviewer will notify your 

committee chair if this happens. Failing to correctly follow these guidelines and/or your 

style manual and/or failure to correct these issues could delay your graduation. 

Once you make the marked corrections, submit a revised copy of the document to 

the Reviewer using Aquila in Word format (latex users may submit using a pdf – this is 

the only exception). Do not delete the Reviewers comments, she will remove them as she 

checks your file. Removing the Reviewer comments will slow the process considerably.  

The Reviewer will verify the completion of all marked revisions and will check to be 

sure no revisions have been made to the content and no changes to formatting or style 

have been made without instruction. If all revisions have not been completed or new 

issues have been created, an extra step(s) in this process may have to be added.  Once the 

dissertation or capstone project has been approved by the Reviewer, you will make final 

copies. Detailed instructions will be provided to you by the Reviewer at the appropriate 

time. Do not print your paper copy on the required cotton paper until your document has 

been approved by the Reviewer and instructions have been sent for finals.  

Publication of Doctoral Dissertations/Nursing Capstone Projects 

 

The University of Southern Mississippi participates in the Doctoral Dissertation  

Project conducted by ProQuest Information and Learning, which publishes doctoral  

dissertations/nursing capstone projects in digital form. ProQuest charges a fee, which is 

part of your graduation fee, to publish, and copyright the document in your name. A 

formal copyright protects your intellectual property interest in the document and does not 

prohibit you from publishing all or part(s) of your dissertation/project. ProQuest also 



 

 

37 

 

publishes a quarterly compilation of dissertation abstracts.  When you submit your 

dissertation/capstone to the Reviewer through Aquila you will be asked to either select an 

embargo period or to make your document available immediately (once approved by the 

Reviewer).  Please do not embargo your document, unless absolutely necessary. Be sure 

you make the same embargo choice on the ProQuest form.  If you change your mind 

about the embargo period after initial submission, let the Reviewer know and she can 

change it (only until finals are submitted, after that, no changes).The ProQuest form link 

will be provided to you once the Reviewer clears you to make final copies. Your 

document will also be published on Aquila which serves as a digital repository for the 

Cook Library, the Graduate School, and The University of Southern Mississippi. 

 The Survey of Earned Doctorates (SED) is also required of all PhD candidates; a 

link will be provided in the final instructions.  Ed.D, DNP, and DMA candidates are not a 

part of this survey. Once the survey is completed the Reviewer should receive a 

“Certificate of Completion” via email from the NORC.  Please turn in a copy of the 

certificate with your finals to be sure you are given credit for completing this required 

survey.   

Policy Regarding the Release of Dissertations 

 and Nursing Capstone Projects 

 Electronic files containing your dissertation/capstone project will not be returned 

electronically to any email address other than one(s) on file in this office unless you have 

provided us with authorization to do so. The authorization must already be on file and 

must be signed and dated giving a specific person permission to receive your file (provide 

their email address). We will not discuss your document with anyone other than you or 
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your committee, unless you have given us permission to do so (this includes your 

typist/editor). 

Family Educational Rights and Privacy Act (FERPA) 

 We cannot discuss your dissertation or capstone project with anyone but you, 

unless we have written permission from you to do so. For additional information about 

FERPA, see  http://www.ed.gov/policy/gen/guid/fpco/ferpa/index.html 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.ed.gov/policy/gen/guid/fpco/ferpa/index.html
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CHAPTER VI 

CREATIVE WRITING GUIDELINES (English Department only) 

The Graduate School realizes that creative writing students’ dissertations may 

sometimes differ from those of other students, but the Graduate School strives for 

uniformity among all dissertations. Follow these Guidelines below in order to help 

maintain Graduate School uniformity. Please read and follow the USM Guidelines prior 

to this page because much of them still apply to creative writers, such as margins, 

spacing, pagination, etc. 

Elements of the Creative Writing Dissertation Manuscript 

See instructions for many of these elements in Chapter III 

  1.  Flyleaf (blank page, not numbered) insert manually into final paper copies 

  2.  Abstract Title Page (not numbered) 

  3. Abstract (numbered, bottom center) 

  4. Copyright page (not numbered, text centered vertically and horizontally) 

  5. Title page – type in the Reviewer approved version of your title page –  

 

      be sure to match all spacing and placement exactly. See instructions in 

 

      Chapter III. 

  6. Dedication (optional, numbered, bottom center) 

  7. Acknowledgments (numbered, bottom center) 

  8. Table of Contents (numbered, bottom center) 

  9. Introduction (numbered, bottom center) 

10. Works Cited (numbered, bottom center) 

11. Text (Chapter I or first story/poem starts with page 1, all pages numbered in     

the upper right margin.)   
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12. Appendixes (if any, numbered as continuation of main text) 

13. Flyleaf (blank page, not numbered) inserted manually into final paper copies 

Preliminary Pages (numbered using lower case Roman numerals, bottom center, resting 

on one inch bottom margin) 

Table of Contents 

Treat genres as chapter titles. For example, if the document is entirely fiction,  

you will have one chapter:  I.  FICTION. If the document is in multiple genres, such as  

fiction and poetry, you will have two chapters: I.  FICTION and II.  POETRY. Treat  

titles of poems, essays, and short fiction as headings under chapter titles. If the  

manuscript is a novel, follow the Graduate School guidelines for formatting non-creative  

dissertations. Type each chapter of the novel as you would a chapter for a non- 

creative dissertation and follow the same guidelines for headings. 

Introduction 

Your introduction is considered part of your preliminary matter. Number all  

the pages of the introduction at the bottom center with the appropriate lower case Roman  

numerals. On the first page, center the word INTRODUCTION one inch from the top  

of the page. If the essay has a title, center it two spaces below the chapter title in all caps. 

Be sure that all work in the Introduction is properly cited as per MLA and that a Works 

Cited section follows your Introduction. 

Text (from this point forward page numbers go in the top right corner, one half inch from 

top margin, one inch right margin) 

Margins 

Follow these margin settings throughout the document:   

 Left margin – 1.5 inches 

 Top margin – 1 inch 
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 Right margin – 1 inch (do not right justify) 

 Bottom margin – 1 inch 

Spacing 

Double-space the text of all prose. Any breaks in a story, essay, or novel may be 

indicated by either sextuple spacing (three returns with a double space setting) or by 

inserting asterisks, centered, double-spaced before and after the asterisk line.  Poems 

need not be double-spaced.  Type poems in whatever format you choose as long as they 

fall within the margin guidelines. 

Headings 

Center the title of each work and set in all capital letters. Titles may not be 

boldfaced or italicized (e.g., BARN BURNING not BARN BURNING). Poem titles may 

vary the capitalization format, depending upon the poet’s intentions. If any of your works 

have section headings, place them flush left, italicized. You may boldface section 

headings. 

Genre Divisions 

If your document contains various genres, include an introductory page for each  

genre. This page is neither counted nor numbered. Center the appropriate word (for  

example, POETRY, FICTION, or NONFICTION) three and one half (3.5) inches from  

the top of the page. 

 See previous chapters for instructions on various issues not covered in this  

Chapter. 
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EXAMPLES 

 

Examples will begin on the next page so that spacing and formatting will be consistent 

with what we require. See notes regarding required pagination. 
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CHAPTER I* 

 

INTRODUCTION 

 Kinesthesia simply stated is to perceive motion.  This may seem to be a basic concept, 

yet kinesthesia is an important sensory systems component that, through integration, is used 

by the individual to move with accurate, fluid, and efficient motion in the environment. In 

everyday life, individuals perform gross and fine motor movements, such as getting up from 

the floor, dressing, writing while copying from the board, and typing. Purposeful efforts to 

visually attend to the entire movement interfere with the smooth flow of the movement. 

Therefore, individuals rely on kinesthetic information to monitor these movements. 

Efficiency of motor performance is dependent on the physical ability to control muscle 

movements. It is also dependent upon the integrity of the afferent kinesthetic input from 

muscles and joint receptors, generated by active and passive movements that guide the 

position, velocity, and direction of movements (Bosworth, 1982). 

 It is clinically important for pediatric occupational therapists to differentiate possible 

sensory deficits, such as a deficit in kinesthesia, Laszlo’s (1981) vertical ramp estimations, 

Ayres’ (1978) Southern California Sensory Integration and Praxis Test, and the 

Kinesthesiometer, each of which have inherent problems with reliability and validity, 

availability, or practicality for use in a clinical setting. 

 

*This will be page 1 in your document (upper right hand corner, Arabic #).  Preliminary pages 

should use the lower case Roman numerals (centered, bottom) as previously discussed. 

 

 

 

 

 

 

 

 



 

 

 

Hypotheses and Research Question 

 

 The hypotheses and research question are as follows: 

 

Hypotheses 

 

 H1 – This study seeks to prove that a student’s age at the time of admittance to the 

nursing program substantially influences success in the program. 

 H2 – This study seeks to determine if the maturity level of the nursing student at the 

time of admittance to the program determines professional success and longevity in the 

workplace. 

Research Question 

 This researcher seeks to determine if …. 

Definition of Terms 

 

 The terms in the research questions were defined theoretically and operationally: 

 1. Age – the number of years a person has been living since birth. Operationally 

defined as the student’s age upon entrance into the nursing program as reported in item 8 in 

the data gathering tool. 

 2. Status – and so forth …. 
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CHAPTER VIII 

 

HELPFUL HINTS 

 

Inserting the IRB or IACUC Letter 

 

 Scan a copy of the original approval letter as a picture file.  Insert the file onto the 

correct appendix page below the header, leaving one space (double-spaced) between the 

header and the start of the letter.  Position the picture on the page so that the margins are 

correct (see margin guidelines). Note: This does not have to be your first Appendix so the 

letter after the heading may vary. 

 The heading at the top of the page should appear as follows: 

APPENDIX A 

INSTITUTIONAL REVIEW BOARD NOTICE OF COMMITTEE ACTION 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

Page Numbers 

 

 Four sets of instructions are included here.  Pick the one that is most helpful to you.  

Remember that your page numbers must be in the same font and font size as your text (Times 

New Roman or Arial, 12 point).  Refer to page 6 for further instructions. 

One 

Guidelines for Changing from Roman Numerals to Arabic Numerals 

Your manuscript must be submitted as one file.  To create different formats of page 

numbers or to restart page numbering in the document, you will need to divide your document 

into sections (within the one file) and change the page number format for each section.  

Specific steps will vary for different versions of Microsoft Word. 

1.  If you have not already done so, insert a section break where you want to    

     change the page numbers.  To do this, click where you want to insert a section        

     break.  On the Insert menu, point to Break and then click the type of section    

     break you want to insert. 

2.  With the cursor in a particular section, go to the Insert menu and choose Page    

     Numbers. 

3.  Choose the page number options you want (click Format and change the page   

     number format), and click OK. 

4.  Repeat for each section of the document. 

Check the USM Guidelines for placement of page numbers.  Make sure you are using 

the same font and font size used in the rest of your document (Arial or Times New Roman, 12 

pt.). 

For more help with pagination, visit the following website: 

http://support.microsoft.com/default.aspx 

http://support.microsoft.com/default.aspx


 

 

 

 

Settings (use these settings with all of the instructions included here). 

 

For the Preliminary Page Numbers: 

In order to place the page number ON the 1” margin as required please follow these steps: 

 

In Word 2007, 2010, 2013 

Click on Insert 

Click on Page Number 

Choose Bottom of Page 

Choose Plain Number 2 (centered at bottom) 

Set the Footer from Bottom to 0.8 (or 0.9 depending on your computer & printer) 

Make sure the font is Times New Roman 12 point or Arial 12 point (to match your text) 

Always check with a ruler after printing 

 

For the remaining pages (beginning with page 1 of Chapter I) 

Click on Insert 

Click on Page Number 

Choose Top of Page 

Set the Header from top to 0.5 

Make sure the font is Times New Roman 12 point or Arial 12 point (to match your text) 

IF you opt to place the page numbers in the main text at the bottom – follow the directions for the 

preliminary pages – but the page numbers will still change from lower case roman to Arabic numbers 

(page 1 begins on the first page of Chapter I) 

 

Two 

The following instructions are for Word 2010, but the process is the same for Word 2007.  

Add different headers and footers or page numbers in different parts of the document.  You can 

add page numbers to only part of your document. You can also use different numbering formats in 

different parts of your document.  For example, maybe you want i, ii, iii numbering for the table 

of contents and introduction, and you want 1, 2, 3 numbering for the rest of the document, and 

then no page numbers for the index.  You can also have different headers or footers on odd and 

even pages as explained below. 

Add Different Headers and Footers or Page Numbers in Different Parts* 

1. Click at the beginning of the page where you want to start, stop, or change the header, 

footer, or page numbering. 

You can press HOME to make sure that you're at the start of the page. 



 

 

 

2. On the Page Layout tab, in the Page Setup group, click Breaks. 

 

3. Under Section Breaks, click Next Page. 

4. Double-click in the header area or the footer area (near the top of the page or near the 

bottom of the page). 

This opens the Design tab under Header & Footer Tools. 

5. On the Design, in the Navigation group, click Link to Previous to turn it off. 

6. Do one of the following: 

 Follow the instructions for adding a page number or for adding a header and 

footer with a page number. 

 Select the header or footer and press DELETE. 

7. To choose a numbering format or the starting number, click Page Number in the 

Header & Footer group, click Format Page Numbers, click the format that you want 

and the Start at number that you want to use, and then click OK. 

8. To return to the body of your document, click Close Header and Footer on the 

Design tab (under Header & Footer Tools). 

 

 

http://office.microsoft.com/en-us/word-help/add-or-remove-headers-footers-and-page-numbers-HA010372690.aspx?CTT=1#BM1
http://office.microsoft.com/en-us/word-help/add-or-remove-headers-footers-and-page-numbers-HA010372690.aspx?CTT=1#BM2
http://office.microsoft.com/en-us/word-help/add-or-remove-headers-footers-and-page-numbers-HA010372690.aspx?CTT=1#BM2


 

 

 

Remember to follow the page number guidelines in these Guidelines.  Within the headers 

and footers, you will need to right click on the page numbers and manually change them to the 

font and font size of the rest of your  dissertation or project (Times New Roman or Arial, 12 pt.).   

*From office.com tutorial, which includes a computer-accessible training video.   

Three 

Preliminary Pages:  How to Start Page Numbering at a Specific Page using Microsoft Word 2007 

(2010) 

Follow these steps in order to get your page numbers to begin showing on the Abstract 

page as page ii: 

1.  Open your Word document and click at the top of the page where you want the    

     page numbering to begin (the Abstract). 

 

2.  On the Page Layout tab, in the Page Setup section, select Breaks, then select   

     Continuous. 

3.  On the Insert tab, in the Header & Footer section, select Page Number.     

     Then select Bottom of Page, then Plain Number 2. 

4.  Double click where the page number is to get the Header & Footer Design   

     tab to open. In the Navigation section, deselect Link to Previous. 

5.  Go to the Pages you need to delete the page number(s) from, and delete the   

    page numbers that begin on the Abstract page. 

6.  Go back to the Abstract page, and highlight the page number.  On the Insert   

    tab, in the Header & Footer section, select Page Numbers, then Format Page    

    Numbers. 

7.  For the Number Format Field, select the Roman numerals (i, ii, iii, …). Then     



 

 

 

    below under Page Numbering, select the “Start at” button, and then enter ii in   

    the field.  Click OK. 

8.  Double-click anywhere in the document to exit the header/footer formatting –     

    the page numbers have now been added to the document. 

How to Switch to Arabic Numerals for Chapter I using Microsoft Word 2007 (2010) 

Follow these steps in order to get your page numbers to switch to Arabic numerals for the 

first page of your main text: 

1.  Click at the top of the page where you want the Arabic numbering to begin. 

2.  On the Page Layout tab, in the Page Setup section, select Breaks, then select   

     Continuous. 

3.  Highlight the page number on the first page of your main text, and in the   

     Navigation section, deselect Link to Previous. 

4.  On the Insert tab, in the Header & Footer section, select Page Number.   

     Then select Top of Page, then Plain Number 3. 

5.  On the Insert tab, in the Header & Footer section, select Page Numbers,   

     then Format Page Numbers. 

6.  For the Number Format Field, select the Arabic numerals (1, 2, 3…). Then   

     below under Page Numbering, select the “Start At” button, and then enter 1 in   

     the field. Click OK. 

Preliminary Page Margins 

 

In order to place the page number on the one-inch margin as required please follow these 

steps: 

1.  In Word 2007 and 2010, click on Insert. 

2.  Click on Page Number. 



 

 

 

3.  Choose Bottom of Page. 

4.  Choose Plain Number 2 (centered at bottom). 

5.  Set the Footer from Bottom to 0.8. 

6.  Make sure the font is Times New Roman 12 point or Arial 12 point (to match    

     your text). 

7.  Always check with a ruler after printing. 

For the remaining pages (beginning with page 1 of Chapter I), follow these steps: 

1.  Click on Insert. 

2.  Click on Page Number. 

3.  Choose Top of Page. 

4.  Set the Header from top to 0.5. 

5.  Make sure the font is Times New Roman or Arial, 12 pt. (to match      

     your text). 

Mac users can find similar instructions on the Office website. 

Four 

Section Breaks vs. Page Breaks 

 

Section breaks are used when you need to change the style and placement of your page 

numbers.  According the guidelines set forth in this document that change occurs where the 

preliminary pages end and Chapter I begins (see Chapter II of this document). A page break may  

 

be needed to separate information, such as the break between Chapter I and Chapter II, if a page 

break is inserted at the end of each chapter it will prevent the Chapter II heading from being 

pushed down the page as you edit Chapter I, for example.  There should be no need to use both a 

section break and a page break on the same page.  



 

 

 

To see if you’ve used either a section break or a page break or both, select the following,  

 
 

Once you are able to see the breaks, you may delete/adjust accordingly. Generally, you 

should place the breaks after the last sentence in your section as opposed to at the bottom of the 

page. 

 

These instructions are not formatted the way you need to format similar items in your dissertation – 

 the instructions were borrowed from another university and the formatting could not be altered.  The page number 

placement shown in some of the examples is lower than we allow – note our required settings. 

 

 
 

 
 



 

 

 

When your breaks are placed appropriately, you are ready to tackle pagination! 

First, in the drop down menu select bottom of page, then plain number 2 (centered, at the bottom.  

Be sure the placement setting is 0.8 so that the roman numeral will rest ON the 1” bottom margin. 

 

Second, then from the same drop down menu format the page numbers for the preliminary section 

to begin with “ii” on the Abstract (remember the Abstract title page, Title Page, and copyright page in 

dissertations are not numbered, the copyright page does not count in the numbering scheme; the Title page in theses 

are not numbered). 

Now that your preliminary section has the roman numerals at bottom center, we can move on to 

the main body of the text, starting with arabic numbers (1,2,3, etc.) at top left. 

Above Chapter I heading, double click until the header information shows up. You will 

have to first, “unclick” “Link to Previous” so that the page numbers do not continue the same 

formatting throughout the entire manuscript: 

 
 

 
 



 

 

 

 

 



 

 

 

Now you are ready to repeat the same process for formatting page numbers. 

Next, format the page numbers for the Arabic numbers. 

 

 

 

 



 

 

 

Beginning on Chapter I, page 1 place the page numbers in the upper left hand 

corner – setting should be 0.5.  From this point forward all page numbers should appear 

in the upper right hand corner of the page and run continuously through the end of the 

document.  Be sure page numbers are in the correct font to match your text, either Arial 

12 point or Times New Roman 12 point. 

PLEASE NOTE: The title pages and copyright pages should not be numbered so 

insert section break without linking to previous to avoid adding page numbers to these 

pages.  See previous notes on this subject. 

 

 

 

 

 

 

 

 



 

 

 

 

 



 

 

 

 

 

 

 



 

 

 

 

 

 

 



 

 

 

Example – the page number must be placed in the upper right hand corner of the 

page on all landscaped pages, no matter what they are. 

 

 



 

 

 

Be careful that you don’t have any “widows or orphans” in your dissertation or 

nursing capstone project.  This is an explanation of what that means. 

 



 

 

 

 

 

 

 

 



 

 

 

 

http://libguides.lib.usm.edu/citation_help 

For help formatting your Reference section go to this website and sign up for RefWorks – there are 

tutorials and webinars there to show you how to use this.  Be sure you select the current edition of the style 

manual you will be using.  There are older editions there that must not be used – to find a more extensive 

list look under “customize” – there are more choices there, but keep in mind that not all of the listed styles 

are acceptable as per the USM Guidelines (http://www.usm.edu/graduate-school/graduate-reader) . Every 

time you sign into RefWorks double check that the correct style manual is selected.   

Under “tools” there is a program that you can download called “Write-n-Cite” – that may be useful as you 

create your in text citations.  Every citation must have a matching reference. 

You are still responsible for entering all of the information in the required format.  This tool is only as 

good as the information that you type in.   Always check your References against the style guide to be sure 

that all formatting is correct as per your selected style guide (check spacing, punctuation, placement, and be 

sure each required element is there). 

For technical support contact Cook Library. 

Allowed style guides (from the Guidelines): 

• Publication Manual of the American Psychological Association, 6th edition. (APA) 

• MLA Handbook for Writers of Research Papers, 7th edition. 

• The Chicago Manual of Style, 16th edition. 

• Kate L. Turabian, A Manual for Writers of Term Papers, Theses, and  Dissertations, 

8th edition. 

• The ACS Style Guide: A Manual for Authors and Editors, 3rd edition. 

• Scientific Style and Format: The CSE Manual for Authors, Editors, and  Publishers, 7th 

edition 

.• Authors’guidelines published in scholarly journals. Use with Grad Reader approval 

only. 
 Latex-USM version (Computer Science & Mathematics ONLY) – Refworks should not be used by Latex 

users (use the tools provided in Latex). 

 

 

http://libguides.lib.usm.edu/citation_help
http://www.usm.edu/graduate-school/graduate-reader


 

 

 

 

 

 

 

 

 

 

HOW TO FILL OUT THE AQUILA FORM: 

 

When you sign-on to Aquila for the first time you will have to fill out a form before you 

can send your thesis, dissertation, or nursing capstone project to me.   Here is what needs 

to be done: 

Title:  Type in your complete title – this must match the title on your approved title page. 

 
Author:  Skip the search box and type in your USM email address, then your name (first, 

middle, last) as it appears on your approved title page.  The type in University of 

Southern Mississippi for the institution 

 
 

Date of Award:  Under season select the semester you will be graduating in (Spring, 

Summer, Fall); the month, day, and year of the Graduation ceremony.  If you are unsure 

the Reviewer can provide that or you can look on the Academic Calendar on the 

Registrar’s website. 

 



 

 

 

 
 

Continued … 

Degree Type:  Master’s Thesis, Dissertation, Nursing Capstone Project – select the 

correct choice 

 
 

Student’s Permanent Email:  Do not enter your USM email address here.  Enter your 

long-term email address, the one not likely to change for the foreseeable future: 

 
 

Degree Name:  Your choices will be Master of Arts (MA), Master of Science (MS), 

Doctor of Philosophy (Ph.D.), Doctor of Education (Ed.D), Doctor of Musical Arts 

(DMA), or Doctor of Nursing Practice (DNP).   There are more choices there, but one of 

these will be the degree that will be listed on your diploma and that is what should be 

entered. 

 
Department:  Select your department. 



 

 

 

 
Embargo Period – if you would like your file to be embargoed select 6 months, 1 year, or 

2 years.  If you are applying for patent or trying to get some or all of your document 

published, you may want to embargo it for a period of time.  The document will not be 

available on Aquila until that time period has passed.  Doctoral candidates need to select 

the same embargo period on their ProQuest form later in the process. 

 
 

Future Permission:  Select one of the options 

 
First Advisor – this is your committee chair.       First Advisor Department – select your 

committee chairs department. 

 
There are fields that follow for the Second Advisor and department, etc.   Fill in the rest 

of your committee in each of these fields. 



 

 

 

Keywords:  Type in keywords or search terms that best describe your thesis, dissertation, 

or nursing capstone project.   

  
 

Subject Categories: using the available terms shown. 

 
 

 

 

 

Abstract:  copy and paste or type your Abstract in the space provided.  Remember that if 

we ask for any corrections to your Abstract you will need to be sure it is changed here as 

well. 



 

 

 

 
 

Skip the comments section. 

*Then Upload your WORD document where indicated (Latex users may upload a pdf). 

*You should have no additional files to upload. 

*Read the open access statement and then check the box acknowledging that you have 

read the statement. 

*Then Click Submit 

The Reviewer will receive an emailed notification that you have submitted your thesis, 

dissertation, or nursing capstone project. 

Your thesis, dissertation, or capstone project will not be visible on the Aquila database 

until the Reviewer approves it in its final version.  Only you and the Reviewer will have 

access to it until the Reviewer approves your document and submits it to Aquila for 

publication.  *Doctoral candidates – shortly after the final document is published on 

Aquila, it will also be submitted to ProQuest for publication by the Reviewer (the 

embargo you set will be adhered to by both Aquila and ProQuest).  Masters candidates – 

your document will be published only on Aquila. 

Please remember that these documents are not to be submitted to the Reviewer until you 

have defended.  Any revisions required by your committee must already be complete and 

accepted by your committee chair. 

Be sure all submitted documents are in compliance with the USM Guidelines.  Your 

document should be in compliance with your selected style manual, but the USM 

Guidelines always take precedence.  Your document should be grammatically correct and 

properly cited when it is submitted to the Reviewer – this is your responsibility.   All 

theses, dissertations, and nursing capstone projects are submitted to Turnitin, to check for 

originality. 
 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Please note that the Graduate School will be changing some 

aspects of these Guidelines in the future.   

 

The change (new guidelines/template) will be optional for those 

defending by the deadlines for Fall 2015 (fall degree candidates 

will be allowed to stay with these guidelines or choose the new 

template). 

 

The changes/new template will be in place and required for 

those defending in Spring 2016 or beyond. Those working 

toward a defense in future semesters should watch the 

Reviewer section of the Graduate School website for these 

anticipated changes, but in the meantime use these rules and 

your chosen style guide. Don’t stress or worry about this, we’ll 

make the transition as easy as possible.  7/22/2015 
 


